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Section 1: Main Screen Operations
Startup
This is the usual startup screen for DecisionPad. It gives you two options to begin a new decision
pad file: New Decision, or Open an Existing Decision.

If you do not get this screen on starting then you likely have a login screen of some sort to:
(1) Continue as a demo to evaluate the software (limited to a maximum 3 alternatives, 7 criteria
and 3 evaluators, prints a demo “watermark” under all printouts, and does not support
import, export or the balloting server)
(2) Provide a full license serial number starting with DP4- to unlock all features.
See the Installation Guide for more information if needed to get to the Welcome screen above. To
purchase a software license contact Apian Sales at sales@apian.com or 800-237-4565.
For a new decision project you can open a ‘New Blank Decision’ that will begin with an empty
matrix screen like this:
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Note: For more about the matrix screen see p. 7 . If you are new to DecisionPad we recommend
you read through the Tutorial Guide, especially the two on the Basics and Handy Tips.
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Or you can begin your DecisionPad file with a ‘Decision Jumpstart’. A Decision Jumpstart allows
you to go to a self-explanatory Wizard to help you quickly build your first draft of the decision
structure. The Jumpstart option begins like this:

If you want to open an existing file, click ‘Open File’ to open one of the sample files or your own.
Or click ‘Open Last’ to open the last file you worked on in DecisionPad.

Main Screen Matrix

The Matrix view is the heart of the structures for DecisionPad. This is where alternatives are
evaluated against weighted criteria. Referring to the screenshot above, criteria are the rows in the
matrix. Such as “Quality” or “Dependability”. Alternatives are the columns, like “Gates by Sally” or
“Welders Anon. The cells of the matrix show your assigned values like “High” or “Good”. At the
top are the current and previous rankings. Weights are listed in a column between the criteria
names and the values.
When you start all the cell values will be listed as question mark (?). As you go through your
alternatives criteria, the question mark will be replaced by values. As long as there are question
marks in the matrix the scores listed along the top will show a range of possible scores; the ranking
is based on the average scores. As more values get set the ranges narrow. Often, at some point,
a winner emerges regardless of what the remaining question marks might be. For example if there
are still question marks (?) remaining for “Fred’s Iron Works”, this may lead to a score range that
cannot beat “Welder’s Anon”.
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Items in the matrix with notes attached, like Fred’ Iron Works above, are indicated by the ♪ symbol.
You can hover the mouse over the item showing the ♪ to see it pop-up, or use the right-click menu
following to attach or edit a note.
If you right-click on the Matrix you will get this popup menu.

The first five items are the same as the main Edit menu starting on p. 31.
Sorts Alternatives by and Sorts Criteria by set rules for how the matrix is sorted with a flyout menu.
The flyout menu view is re-sorted every time something in the decision model changes. Here the
alternatives are currently unsorted, in the same order as the tree at the left of the screen. They
could also be sorted by rank, by the selected criterion’s scores or alphabetically. To find more
detail about these options see the View Properties topic on p. 61.
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Tree View

The tree view shows all the components of the decision. There is an Add to Group at the end of
each criterion group, and an Add at the end of everything for top level items. Note the optional
groups outline structure for Criteria which can be nested as deeply as you like.
You can double-click on items in the tree to edit their properties. With the exceptions of View >
Matrix, Scale > Comment and the four default Text Styles you can drag-and-drop items within a
list, such as reordering the alternatives or moving a criterion to a different group level.
When a report is displayed instead of the matrix, all the editing is done through tree selections.
You can make selections in either the tree or the matrix for editing.
The squares and folders next to the items in the tree give you clues to aid navigation and editing.
Categories like Alternatives, Criteria and Views show yellow folders. The groups for Criteria have
yellow folders. Scales and Text Styles show a green square when they are used in this decision or
an empty square when defined but unused. Add items also have empty squares.
If you select an item in the tree it will get a red border. If you make a selection in the matrix, all the
tree items associated with it will be marked with blue borders. In the example above a matrix cell
was selected. If you are working with a large matrix, it is sometimes faster to select an item in the
tree that is off-screen rather than scrolling through the matrix.
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If you right-click on a Tree item you will get this popup menu:

The first eight items are like the main Edit menu starting on p. 31. The last two provide an easy
way to move items up or down the tree.
The Tutorial Guide has a section on using criteria groups which shows how to use these “outline
editing” features.

Toolbar Buttons

The buttons from left to right are:
File Open and File Save (p. 14)
Print, Print Preview and Page Setup (p. 17)
Cut, Copy and Paste (p. 32)
Undo and Redo (p. 31)
View Properties (p. 58)
When multiple evaluators are enabled three buttons are added to the right end:

Alternatives by Criteria matrix screen (p. 11)
Evaluators by Criteria
Alternatives by Evaluators
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Multiple Evaluators 3D Matrix
When multiple evaluators are enabled (see p. 21)
there are several obvious changes to the main
screen: the toolbar gets 3 new orientation buttons
and controls for selecting the z-axis appear, and
the matrix is labeled with the slice selected.
on
The three added toolbar buttons
the right end refer to the two matrix axis that will
appear on the screen:
alternatives across; criteria down; z-axis evaluators (as shown above)
evaluators across; criteria down; z-axis alternatives, must-haves
alternatives across; evaluators down; z-axis criteria, weights, scores, ranks
Think of the 2D screen as if it were one from a stack of screens (the z-axis). Which slice is
selected uses a control like this:

The pulldown list gives all the choices in the stack, or you can use the buttons to go to the next
option or jump to the ends.
Note that when you type entries into the matrix the global-individual rules will be enforced:
� Global -- (g) -Summary
� Individual -- (i) --

– the values or weight is the same for all evaluators, settable in the
– each evaluator sets their own in their own slice only

For more on these g-I settings see p. 26.
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Auto-Save Files
After about 15 minutes of making changes to a new or just opened file you will get the Auto-Save
dialog:

You can click the Save Now button to save this project to disk, which acts like a File > Save if the
file already has a name or like a File, Save As if it is a new one.
The Save As Now forces a new file name for your edited decision project.
The Wait button is like a snooze alarm. It does nothing now but waits about 5 more minutes and
reminds you again.
The Do not show again checkbox applies only if the file is actually saved. If you press Wait it is
ignored. If you were to click one of the Save buttons with and check Do not show again, after the
next 15 minutes of changes the file would simply be saved without asking again.
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What if it “doesn’t make sense?” Checklist
DecisionPad is a communication tool that helps organize the reasoning behind a decision and
explain it to the rest of the organization. When a decision “does not make sense” to you then it is
time for a little troubleshooting – until it explains the reasoning clearly to you it certainly will not be
clear to anyone else. Here is a checklist to review for any decision before it gets distributed:
(1) Check the scales for the criteria – have the right ones been applied? Is the best-worst
sense correct? Do the number or date scales have appropriate end points that do not
overstate or understate the usefulness of the alternatives?
(2) Open the weights report – do the weights look correct?
(3) Open the Weight Sensitivity report and scroll to the end. Do the criteria score ranges
reflect the differences in the alternatives?
(4) Are there too many unknowns in your decision? Does the amount of unknowns cause
a wide range in scores which makes the ranking not useful?
(5) Turn the impact arrows on – do any of them surprise you? They might indicate a
weight or scale issue missed earlier.
(6) Is a criterion missing?
The last one happened to us putting together a model for our business. When we got “done” it
came up with a very non-intuitive answer. After some thought, we realized that a criterion we were
not conscious of had been left out. After we added the missing criteria our decision fell into place.
Imagine trying to explain that recommendation, with or without DecisionPad, before realizing we
had forgotten one of the critical factors?
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Section 2: Main Menus
File Menu
New Blank Decision:
Provides an empty decision matrix to which you add criteria and alternatives directly.
Decision JumpStart:
JumpStart is a self-explanatory Wizard to help you build a matrix following the instructions on each
screen. Think of JumpStart as a way to develop a rough draft. You choose a decision type which
is followed by several screens of typical criteria. These suggestions can be used verbatim but are
really intended to stimulate your own thinking about criteria for your own decision. Then JumpStart
helps with scoring, scales, weighting and the addition of alternatives.
At the end you have a matrix to begin the detailed thinking. If some information when doing
JumpStart is not available or controversial just leave it for later.
Open, Close, Save, Save As:
DecisionPad files are xxx.dp4 with the most recent automatic backup as xxx.dp4.bak. Selecting
Close from the file menu closes the DecisionPad file and leaves the screen blank. Closing a .dp4
is not the same as selecting File > New Blank Decision.
Also see the Autosave rules on p. 11.
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Import:
An import text file is going to be interpreted as rows and columns according to the figure below
regardless of how your current matrix is displayed on the screen. The imported file has to have its
data in the order shown with no extra information:
Column 1

Alternative Names

Row 1

Must Haves (optional)

Weights (optional)

Notes for Criteria (optional)

Grouping Levels (optional)

Criteria Names

Notes for Alternatives (optional)

Values
- or Alternating Values and Notes rows
including Weight or Must column notes

The imported data will be merged with the open project, adding alternatives or criteria as
requested. Criteria groups or scales cannot be imported; you will need to add them with
DecisionPad edits afterwards. In other words, importing weights or values requires the criteria
scales and groupings must be setup first.
After providing the import file name this dialog appears:

First specify which rows and columns are present in the import file, then click the Scan File button
to get:
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The import scanner shows what it read from the file and its interpretation of what it read if usable.
It matches up alternatives and criteria by names, giving you the option to ignore mismatches or
add them at the end. Blank alternative or criteria names are not permitted.
If the Read box shows junk then the most likely problem is the encoding. Try it the other way and
rescan. The default expects UTF8 encoding which is the same as 7-bit ASCII or 8-bit ANSI unless
there are special characters above the ANSI range (like â © or Ω). For UTF8 the special
characters become 2, 3 or 4-byte sequences in the file. Unicode encoding will interpret all file
bytes as one or two 16-bit words.
Unmatched criteria added are un-scaled; you will need to assign a scale after the import.
Un-scaled criterion’s values can be imported as un-scored comments or ignored. Once you assign
a scale DecisionPad will convert the comments to fit the scale assigned where possible.
When the 3D multiple evaluators are enabled in the open project you have the choice of which
evaluator or the summary the values should go into. These will follow the (g)-(i) rules:
� If you import values into the summary the (g) global criteria will be affected for all
evaluators.
� Importing to a single evaluator only sets its (i) individual values.
Import is not supported in the demonstration version.
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Export:
You can export the contents of the decision matrix as a comma- or tab-delimited file of rows and
columns in this format:
Column 1
Row 1

Evaluator Name

Alternative Names

Must Haves (optional)

Weights (optional)

Notes for Criteria (optional)

Grouping Levels (optional)

Criteria Names

Notes for Alternatives (optional)

Values
- or Alternating Values and Notes rows
including Weight or Must column notes

The exported file is going to be organized in these rows and columns regardless of the way the
matrix is currently displayed on screen. Each item goes into an exported cell, thus long notes will
be one cell even if it takes several lines to show it normally. You have control over which elements
go into the exported file with:

Columns exported can be separated by commas or tabs. Enclosing all fields in quotes makes the
file a little bigger but may be safer for some targets. In any case if DecisionPad sees special
characters in an entry like commas, blanks or new paragraphs it always wraps that entry in quotes.
Notes which have more than one paragraph will export with the line breaks. If the entry itself has
quotes in it they are doubled.
These conventions are common in the industry. A .csv file will open directly in Excel, though notes
will likely require you to change those cells’s format to text type with line wrap to see the whole
note.
The default character encoding is UTF8 which behaves the same as 7-bit ASCII or 8-bit ANSI
unless there are special characters above the ANSI range (like â © or Ω). For UTF8 the special
characters become 2, 3 or 4-byte sequences in the file. Unicode encoding will export every
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character as one or two 16-bit words. If your project uses any extended characters then which
encoding you need depends on the target for your exported file. For example Word and Notepad
accept both encodings but Excel prefers Unicode.
When the 3D multiple evaluators are enabled you have a choice of which evaluator to export, one
evaluator per file.
The Optional Rows and Columns will be enabled depending on the matrix design.
Criteria Group Levels will export G for a group or C for a criterion, plus a number indicating the
level down from the stop starting at 0. These may be useful for other targets but a DecisionPad
import would ignore this column.
Export is not supported in the demonstration version.
Printing:
When printing from the Decision Pad file the matrix or report view active on the main screen is the
one that will be printed. Your DecisionPad printing layout can be formatted by using the File >
Page Setup and/or View > View Properties for layout instructions and to adjust page margins.
The Print Preview screen has a print button that sends the entire document to your default printer.
For control of which pages will print and to what printer, use the File > Print menu.
While in Demonstration Mode a “watermark” will print over the pages. The watermark will
disappear in licensed installations.
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Project Menu
Scoring:

The choices here determine how the values for alternatives and criteria will be evaluated to provide
the rankings:
Weights → How important each criterion is
Scoring → How useful the criterion’s entry for an alternative is
For setting importance there are four approaches:
Percentage weights total 100% automatically within each criteria group are at the top level,
thus editing weights within a group do not affect the subtotals like they do with numeric
weights or points.
High-Low weights use words instead of numbers. Internally the evaluation algorithm
converts them to numbers using the Ratio specified. The Ratio is set to 3 by default as this
seems to fit people’s expectations but you are welcome to change it to anything between 2
and 10. Generally speaking word weights are best with no more than one grouping level;
for deeper nesting like Analytic Hierarchies use numbers or points.
Numeric weights are assigned the each criteria and then sub-totaled through groups to a
grand total at the bottom of the matrix. Numeric weights must be positive numbers or zero.
After setting the relative weights you can force the total so your weights can be expressed
in parts of 100 or 1000 for ease of human understanding, although only the relative weights
matter in the analysis. The weights are applied to the scores for each cell to produce the
alternative’s total score in a weighted-score analysis, or in full PhD-speak a “multivariate
weighted utility analysis”.
Points assigned to each criterion are also sub-totaled and totaled. The difference from the
two methods above is that the Total Points will be shown instead of the Total Scores at the
top of the matrix. The evaluation for a scale’s answers says how many of those points are
given and is expressed as 0 to 100%. For example if ‘Good’ is 60% and the criterion gets
20 points then that alternative receives 12 points net. Negative points are allowed in the
point totals although these should be avoided if possible because the subtotaling process
can become confusing.
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Mathematically, except for round off differences, these methods all produce the same rankings.
However the people in your organization may be familiar with an evaluation method that adds up to
250 points or does scores from -5 to +5, so the DecisionPad matrix will be clearer if it uses these
instead of the default 0-10 scores. One less impediment to getting the decision made.
Percentage or word weights can be set by group by individual evaluators in a 3D matrix because
each group is independent. The subtotaling for numeric and points would become
incomprehensible in ballots.
If you select Numeric or High-Low weights then the next choice is the Scoring. The default range
is 0 to 10 but you can use any range you like so long as the low score is numerically less than the
high score. The absolute numbers do not matter in the ranking analysis; only the relative scores.
The conversion of a criterion’s entries to scores or point percentages is set by the Scale assigned
to each criterion. For more on Scale scoring see starting on p. 64 and the Tutorial Guide Scales
and Scores which has examples.
Enable Must Have Qualifications adds a column to the matrix where a minimum acceptable value
can be set for one or more rows. Any alternatives whose value is unknown or scores less than the
Must Have will be marked DSQ for Disqualified in the rankings and with a red X next to its value in
the matrix. The total score or points will still be computed. Sometimes you will find a disqualified
option scores well otherwise, which might suggest renegotiating that requirement. Must Haves
cannot be applied to scales that do not consistently get better or worse.
It is important to separate a Must Have from Scoring to avoid skewing the analysis. For example,
say you were looking for office space and your theoretical requirements were 5000 square-feet,
with anything up to 8000 square-feet being better (to be balanced against the cost and other
factors in DecisionPad of course). You would setup the scale to rate the sizes over a larger range
to accommodate some options at 4500 square-feet or 9000 square-feet, then set the Must Have at
5000 square-feet which would disqualify the 4500 square-feet property. However you might
discover that if you told DecisionPad to ignore that limit, the 4500 square-feet property would
become the clear winner. Now you have the option to be creative to see if there is a way to make
4500 square-feet work (like paying for offsite storage) instead of blindly accepting what may have
been a somewhat arbitrary cutoff originally.
Not Ranked (NR) cutoff sets the score spread that takes an alternative out of the ranking.
Normally this is set to 20% so if an alternative has a score range of 1.5-3.4 out of 10.0 it will be
ranked according to the middle of its range while one with scores 1.5-3.6 would be NR. Setting it
to 0% would only rank alternatives without unknowns and 100% would rank everything.
Overall Notes:
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Overall Notes capture information about the decision structure, the documentation process and to
clarify elements of your reports to your audience.
Select the note category from the list and then type into the Edit box. The color, bold, italic or
underline settings within the note will be applied to what Text Style is selected in the View
Properties for a particular report. There are Paste and Paste Unformatted buttons for a choice of
whether to paste with text formatting or without. Generally the Unformatted one is best coming
from another software product to give you DecisionPad global text style control.
You can also attach notes to alternatives, criteria or value cells in the matrix. Any of the notes can
be shown in the report views.
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Evaluators-Users:
In some decisions it is helpful to explicitly show the
differing viewpoints of stakeholder entities or individuals,
say when selecting a new software system that will be
used across departments. One vendor may have the
ideal solution for operations, another for sales and third
for accounting yet only one vendor must be picked for all.
It may help reach the best compromise to show each
department’s evaluations separately. DecisionPad lets
you do that by adding a third dimension to the matrix, one alternative-criterion evaluation for each
department plus a computed summary. (Scatterplot reports p. 60 can aid in finding the best
compromise).
In another case you might want to expedite the first cut at a selection without a meeting. You could
construct a DecisionPad matrix with 3D enabled and the people whose input you want as
evaluators, then invite them to contribute their views. Sometimes you get lucky and the summery
shows a high degree of consistency, but if not you have the significant differences out on the table
for a productive meeting.
Gathering the inputs can be done with Web, Balloting (see page 38) where people can supply their
inputs in a secure fashion through a web browser from anywhere.
The summary is an “average” of the evaluators. Think of it as trial consensus for discussion. The
detailed rules are given on page 26.
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Evaluators Tab:
When ready to enable multiple evaluators for your DecisionPad project, select the EvaluatorsUsers menu item for an empty evaluator list:

The Administrator selection gives you the option to make access to the DecisionPad project file
conditional on a user name and password, which also encrypts the file itself. If you chose that
option you get:

If your purpose is to add evaluators, the 3rd dimension, then select Evaluators and click Add New to
add the first one to this Evaluators dialog tab:
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There are two sets of properties for the evaluator: those showing up in the decision matrix and its
reports, or those used by the administrator to contact the individual. Often the “evaluator” for the
matrix is the departmental or stakeholder role, like “Accounting” in a corporate decision or
“Farmers” in a water-use decision. The contact is the individual representing that group. (One way
to expedite complex decisions is to de-personalize them).
An Evaluator Matrix Name is required. Everything else is optional unless you intend to use the
Web Balloting feature which requires the New Login button, and if you intend to email invitations to
participate in balloting then the Contact Name and Email address will also be needed.
Delete removes the selected evaluator. Delete 3D removes all evaluators, collapsing the matrix
back to 2D keeping the summary as its values.
As you add evaluators they will go to the end of the list. If you want to rearrange the order, you
can do that with the Tree view once you return to the main screen.
Logins are set with

The login user names must be unique within this project, though they can be reused for other
projects. DecisionPad requires moderately strong passwords according to the rules shown.
Unacceptable passwords: ‘Unlock’ (too short, English), ‘Password’ (obvious, all letters)
Good passwords: ‘A76bz’ (not a word, mixed), ‘mille--##’ (not English, random punctuation)
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The Switch to Advanced button gives you more control over access for balloting, or for access to
subsets of the .dp4 project file, or for letting evaluators add themselves. See p. 27 for the
advanced screens. Once you have started to use the advanced features you will not be able to
return to this simpler one. Advanced is not supported in the demonstration version.
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Global/Individual Tab:
The second tab of this dialog specifies how evaluators set values, weights or must haves:

{show for non-adv tabs }
The options are:
� Global -- (g) -� Individual -- (i) --

– the values or weights are the same for all evaluators
– each evaluator sets their own weights or values

Imagine a furniture choice. Each alternative will have a color (beige, grey, teal) which would be
global since it does not matter who is looking at it; it’s a fact. However each evaluator is going to
like different colors so their subjective ratings are individual.
Or say the criterion is cost, which is global, but you might want each evaluator to indicate how
important the cost criterion is so you make the weights individual. Or maybe not, depends on the
organizational structure for this decision.
Usually these are subjective = (i) versus objective = (g) but not always. Some subjective
evaluations may be set globally by the decision manager while leaving others to the evaluators.
(You can see how really complex decisions might lead to using that Advanced button).
The matrix views enforce the g-I rules for entry. An individual evaluator can only make entries to
their own and global values can only be set in the summary. This may seem a little inconvenient
sometimes when you have to switch the view, but it was a tradeoff in order to prevent accidentally
changing things which was happening too often otherwise.
How does the summary summarize (i) items? Depends on what they are:
� Alternative values average the number for ratings, ranks or numeric scales, or average the
box number for checkboxes or average number of seconds for dates. For checkboxes,
ratings, rankings and dates the result is rounded to the nearest value that can be displayed
in the summary. There are no fractional checkboxes.
� Weights are ratio-averaged, reflecting the average impact on the decision regardless of
how the numbers are expressed. In other words it does not matter it one evaluator’s
weights add to 100, another’s to 10,000 and a third to 546 – the summary reflects the
consensus on relative importance.
� Must haves are the worst-case requirement.
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Once the summary sheet is filled in by these rules, it is scored and ranked from what is visible in
the worksheet.
Impact arrows or bars in the matrix (p. 59) are computed within each evaluator or the summary,
reflecting the strengths and weaknesses as seen by that evaluator.
Self Register Evaluators:
This permits evaluators to add themselves to the matrix:

The default is Never. If enabled then the login dialog for opening ballots will have an option for a
potential evaluator to add themselves by supplying their own login user name and password, plus
whatever additional information you have required here.
Advanced Users/Evaluators:
Users and Evaluators are two distinct roles which are linked:
�

Evaluators each have their own alternative-criteria worksheet and provide independent
ratings for the decision, usually representing a department like Accounting or Eastern
Region

�

Users are login roles for access to the project file and web ballots, usually individual people,
each with a specific password and contact information

In the default management of evaluators earlier the linkage was automatic: each evaluator had its
own user properties and there were no extra users. All evaluators had the same access privileges
to the ballots or project: to set all their individual values but no global values. Advanced lets you
separate the roles and specify differences in detail, such as letting one evaluator in finance also set
global criteria like costs..
An Evaluator always belongs to one User, but additional Users can be set up which do not have
any evaluator privileges, perhaps to enter global information or setup reports.
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The list here is of users with contact name and email address. The list can be sorted using the
buttons at the lower-left. A user can be tied to evaluator or not depending on the 3D column
checkboxes.
The evaluator order can be set in the main screen using the outline tree. If an evaluator is defined
it must have a name.
The DecisionPad Administrator is predefined and has permissions to change anything, including
everyone else’s permissions. The administrator can be linked to an evaluator if you wish.
Each user can have a login defined which controls their access to ballots or the project file
according to the next two dialog tabs. That is why you can define users without multiple evaluators
by not enabling 3D, say to give someone else the ability to edit report views but not the decision
matrix.
Enable 3D Matrix is set to enable the evaluator axis. It can also be turned off to covert the matrix
back to Alternative-Criteria only using the 3D Summary as the entries.
Ballot and Project Access:
The permissions associated with each Advanced user role are set by the next two tabs:
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The list on the left represents roles, like “non-evaluators” or specific users. Then you can control
what they have access to for ballots or for the project file.
Tip: the best strategy is to setup the most general roles first, then where necessary make
exceptions for specific individuals. If you do a lot of hopping up and down it will get mighty tiring.
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Text Styles:

Changes to the Text Styles are saved as the changes are made, so this selection dialog only has a
Close button. The first four names are built-in. These four may be copied or edited but not
deleted.
The buttons above the list specify the editing action: pencil point to add a new one, pencil body to
edit the selected style, pencil eraser to delete an unused style or camera to copy the selected one.
Editing will be with the Text Style definition dialog described on p. 70.
Logo:

Your logo image is available for printing with any report or matrix. To replace the “your logo”
placeholder we supplied, click either the File or Paste buttons. Either way a copy is made into the
DecisionPad project file, so if you change a logo image file you need to return here to re-import it.
The image is shown here at full-size; you can adjust the size in any View where it used.
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Edit Menu
These items apply to the tree or to the matrix view. Generally speaking the Report views are not
editable directly, only through their View Properties. The Matrix also has View Properties.
Undo and Redo:
Each time you edit something a snapshot is taken of the decision structure. The most recent
dozen snapshots are kept and you can undo or redo within that set.
Insert:
This has a flyout menu for what to insert:

These may not all be enabled, depending on what you last selected in the matrix or tree. They will
bring up an empty definition dialog appropriate to each type. See the Definition Dialogs section.
Edit:
Brings up the definition dialog for whatever is selected in the tree or matrix. See the Definition
Dialog section about them.
Clear:

This is the way the dialog would appear if a matrix cell was selected, giving you a choice of
clearing the value and note for that cell, or its alternative, or its criterion. If the selection was on an
alternative or criterion label in the matrix or tree only one choice would be available.
Only the Values and the notes attached to the Values will be cleared. The alternative, criterion or
any notes that are attached to them will not be cleared.

DecisionPad 4 Reference Guide –4/6/2011 – © 2009-11 Apian Software Inc – Page 31 of 86

Delete:
The Delete menu option pops up a confirmation dialog for whatever was selected before removing
it. You may not be able to delete certain built-in items like the Comment scale or any scale or text
style in use.
Cut or Copy:
Puts the object selected on the clipboard in DecisonPad format, and when appropriate with a text
version. If you cut or copy an Alternative, its description and all of the values in its column go to
the clipboard as text.
Paste:
Paste uses the selection in the tree or matrix as its insert point if there is a compatible object on the
clipboard. If you cut or copied an alternative the paste function will insert the alternative and all of
its data. If you copy and paste an alternative the name will be changed to “Copy of” and a new
alias given. Similarly for criteria, scales or text styles.
If there is just text on the clipboard when you paste to alternatives or criteria, that text will name
new alternatives or criteria, separating the names at line breaks or tabs in the clipped text. For
example, if you already have a list of alternative names in Excel, you can block copy and paste
them into DecisionPad to quickly create the alternatives. With Criteria they would be named
without scales which you would assign by editing in the usual way.
Values Button Set:
You can select a criterion from the outline tree (in 3D it will be assumed to be for the summary) and
main menu or from the matrix view with main or right-click popup menu.
When a criterion’s scale has discrete values – keywords, ratings or rankings – they can be set
using an array of buttons:

DecisionPad 4 Reference Guide –4/6/2011 – © 2009-11 Apian Software Inc – Page 32 of 86

Each row is an alternative, and the buttons are labeled with the possible values. The [?] button
means no value, an unknown.
The three Sort buttons at the top let you reorder the rows as much as you wish. A common
practice for subjective values is to quickly make some settings, then click Sort and see if they are in
the order and with the profile that makes sense to you. This is particularly helpful in meetings as
the participants talk through each criterion.
By Pairs lets you set relative values for criteria two at a time.

Moving the sliders lets you reflect the relative usefulness of the alternatives for this criterion. As
soon as you set at least one comparison for each alternative the Finished button becomes
enabled. You can then do as many more as you wish; more will refine the relationships all the way
up to the maximum which compares every alternative against every other.
Paired settings help make a good first draft, by being the easiest way to get a first cut at the values
with a modest number of alternatives. Generally you will want to fine-tune the results in the button
setting screen so the profile reflects your evaluations rather than just accepting the paired results.
The Next Button allows you to easily navigate through your alternatives to adjust value settings
without having to return to the matrix screen each time.
Weight Slider Set, Point Slider Set or Weight Button Set:
For percentage or numeric weights or for points you will set a sliders screen like this:
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The sliders are a great way to set the relative importance of a set of criteria. You can quickly set
your first impression, click Sort for the profile, adjust, Sort again, until it represents your
requirements.
By Pairs operates the same as for Button Values on p. 33.
When the criteria are grouped each setting screen is either at the top level or within one group
such as the example here. It works at that selected level which may be all criteria, all groups or
some mix of them. This will be clearer if you look at the criteria groupings in the Tree View. Each
weight screen is for a node of the criterion tree.
You can type a new weight into an entry at the right end of a slider bar. It will be checked and
updated when you strike the Enter key, or move away with the Tab key, or click a button or in
another edit field.
For Percentage weights, a change to one weight will cause the others in the group to be adjusted
automatically so the total remains 100%. If you select Manual instead of Auto in the example
above and change the second weight from 23 to 25 you get:

The running total is shown after every entry change so you can set the values as you wish so long
as they end up totaling 100% before you click the OK button.
For Points or Numeric weights, the total within this group is shown along with a New entry and Set
button to force the total. Generally this is the last step after the relative importance has been set.
If the weighting uses words instead of numbers it will present a button screen that operates as
described for values starting on p. 32.
Add to Experiment:
This is used to take Snapshots of what-if changes for a tracking report. To start this process see
Views, New Experiment Report on p. 36.
Prune Alternatives:
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Prune Alternatives provides a way to remove alternatives according to a rule. Which rules are
enabled will depend on the current state of the matrix. For the example above, the Must Haves
were enabled in Project > Scoring so some alternatives were disqualified, otherwise those DSQ
choices would be disabled.
The Best selection will keep at least as many as selected and allow for decision ambiguities due to
unknown variables. In other words it keeps all those which could be part of the top number. For
example you might ask for the top three but find several more are kept because they could also be
in that top three, depending on how the unknown (?) values turn out. The WithNR and WithDSQ
mean they will be included in the best selection based on their scores.
The First selection simply takes alternatives top down in the tree. Rather than delete a lot of items
one at a time it may be faster to drag the keepers to the first part of the tree and prune it.
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View Menu
View Properties:
Brings up the View Properties dialog for the currently selected matrix or report view. See the
definition dialog on p. 36 for more.
New Matrix:
Brings up the View Properties dialog to define a different matrix view than the built-in one. You will
have flexibility in the rows and columns that are visible and their order.
New Report:
First pick the type of report you want from the flyout menu which brings up the View Properties
dialog. Then you can refine its appearance.
New Experiment:
This is a special kind of report which starts a “what-if” recording process by capturing the current
state of the decision as a Baseline: all of the weights, values and scoring. Then as you make
changes their effect is tracked for you and displayed in the Experiments report. This can be helpful
in showing the decision thought process -- such as dealing with controversial items -- when
explaining the recommendations.
Once you have created the Experiments report, which starts out empty, you make what-if changes
to the decision. When you get to a new configuration of interest, use Edit, Add to Experiment or
the F11 key to capture it which brings up this dialog:

DecisionPad will take a snapshot to show any changes from the Baseline in the Experiments report
when you click OK.
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The Step Name is required because it will head the changes column in the report. The Note is
optional. Keep the Step Name short – often the suggested “(1)” is enough – and use the Note for
more commentary since the exact changes will be tracked for you
In the What’s Next section you can elect to have DecisionPad Revert to the Baseline after this step
or keep on with a progression of changes. You can also indicate when you want to End the
Snapshot Captures. This gives you the option when done with the captures to return to the
baseline or not.
After each capture, the Experiments report will update to show what you have done so far.

Open Window for View:
If you have closed the window for a View but have not deleted it, then this lets you re-open the
window.

DecisionPad 4 Reference Guide –4/6/2011 – © 2009-11 Apian Software Inc – Page 37 of 86

Web Menu
Balloting:

Balloting lets people contribute to the decision directly through a browser from anywhere with
screens like the ones above. Apian provides a cloud service where you as the decision
Administrator can upload selected ballots for people to fill in, and invite them to participate using
the email invitations (see p. 49). Weights can be set by sliders and ratings with checkboxes as
shown above, and notes can be added. You have control over which issues are available during
each balloting session.
The ballot setup builds upon the Project->Evaluators-Users settings (p. __ to __), such as global
versus individual criteria or whether potential evaluators can add themselves by creating their own
login.
Ballots might be used once to get a rough-draft of decision matrix. Or they might be used one item
at a time during a meeting – in one room or remotely – to collect and then discuss each issue. Or
you might just use it to delegate factual entries for some criteria.
Balloting can be an iterative process, asking for certain inputs, collecting them, sending out
requests for other items, and so on. For example say you have a number of alternatives and a few
evaluators to start with. Rather than have everyone take the time to fill in all the entries initially you
could do it in steps. First create a matrix with all the criteria and alternatives, but to begin with
make all the criteria (i) individual even if they are factual. Assign each evaluator a different set of
alternatives to let them investigate and ballot on, covering the assigned factual items plus any of
the subjective ones they have information on. Close and collect the ballots. Since DecisionPad
summarizes just the evaluators with opinions, the summary will show those facts plus preliminary
information on subjective items. Since some of the subjective criteria will relate to the vendor
rather than the specific product, you may have gathered multiple opinions on those criteria already.
For the factual items go into the Project->Evaluators-Users and the G-I tab. Change the factual
criteria from (i) to (g) which will populate all of the evaluators with these fixed settings. Now
examine the results. It is likely you have enough information to focus on the most promising
subset of the alternatives. The subjective ratings gathered so far have been mostly from one
evaluator, and since they will have different interpretations of “good” or “excellent”, the summaries
cannot be taken as conclusive yet. The next step would be to assign multiple evaluators to the
most promising alternatives for another round of balloting. When you see those results you can
resolve the differences and close in on a recommendation efficiently.
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If you are running the demonstration version you will be able to experiment with the balloting setup
but will not be able to upload with Start Ballots. The demonstration version does not have access
to the balloting cloud server.
The screens shown here are for a browser with javascript enabled, which has become normal
given the number of popular sites that take advantage of it just as DecisionPad does. We
recommend participants enable javascript but in case it is disabled the selection screen will have
buttons for selection and the weights screen sliders will be replaced by number entries.
Check the Tutorial on balloting to see the whole flow and a typical path. The material below is
organized for reference purposes.
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Page Template Tab:
The first tab of the ballot setup dialog for a new file is:

In many cases these options are enough: set the decision project title to something more
meaningful and perhaps add a logo image. The Logo options refer back to the shared logo:

There is one shared logo image for a project set with the Project, Logo menu item p. 30.
If you click the Show Advanced button is expands to more text and ballot content options:

The color, bold, italic or underline settings will be applied to whatever Text Style is selected in the
View Properties for a particular report. There are Paste and Paste Unformatted buttons for a
choice of whether to paste with text formatting or without. Generally the Unformatted one is best
coming from another software product to give you DecisionPad global text style control.
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Reset Text will go back to the DecisionPad default.
The Text Item pulldown list gives you control over most of the labels and messages used by the
on-line ballots.

The Title and Footer will appear on all ballot pages. The Login Prompt is instructions for the first
screen, and the Add New Evaluator Prompt appears on the self-registration page when you have
made that option is available.
Warn No JavaScript is a message after login to let the decision participant know they will have a
better experience if they turn JavaScript on in their browser: they will get sliders for weights instead
of number entries and they will be able to add notes to their opinions. If you set this message
blank the notice page will not appear.
The next five Prompts are instructions on the various entry screens. The first will appear on all
weight or value screens. The three Weight instructions depend on how the weights will be entered.
For percentage weights it will be Sliders when JavaScript is available and Numbers otherwise, and
the last is for Word weights by checkboxes.
The Administrator Contact appears as help or with error notices. You would usually provide your
phone and/or email here for questions.
Each of these messages can have its own character style. The last four do not display a message
but set the body text style for categories of pages.
The Decision Notes Page settings enables a button in the ballot screens which bring up whatever
notes you want the respondent to see, the default being all the notes.
Allow Note Entries controls the respondent’s ability to supply notes of their own.
Who and What Tab:
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This is where you identify who is going to participate in this round of balloting, and what items
specifically they are to supply information for.
Remember that users are anyone who has access to DecisionPad in some way, while evaluators
are those users who can have visibly different opinions on the weights or ratings. For example a
user could be an evaluator as they are here, or they may be an assistant who is entering factual
information that applies to all evaluators.
The ballot selections available are contingent on the user-evaluator having permission to enter a
particular item. If a choice does not show up here that you expected, go back to the Project,
Evaluators-Users menu (p. 21) and edit the permissions. If the basic Evaluator setup is used then
Evaluators will only be able to set (i) individual items and only the Administrator will be able to set
globals. Since the default is for all criteria to be (g)
global you will see “"Nothing ballotable”
messages until some criteria are set to (i).
Weights are set within a group or at the top level, so when you select a particular group it means
the weights of all criteria within that group are individually settable. When you make Top Level
Weights ballotable, then the groups at the top become individually settable.
If Project->Evaluators-Users permits evaluators to add themselves by self-registering a login, then
you will see an entry for Self-Registered evaluators in this list. They can have different balloting
abilities from evaluators you add as the administrator.
Net Ballots Tab:
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This takes the rules you have specified so far and displays what ballot pages each evaluator/user
would actually see. You can sort them and also copy the result to the clipboard, say to paste into a
word processing program to print.
Monitor Status Tab:
When the balloting has not started you will get this message:

Once balloting is started it looks like this:
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This confirms that the ballots have been uploaded and are waiting for evaluator input. As
evaluators make entries you can refresh this screen to monitor progress, or close out of
DecisionPad and come back in an hour or a day to check. DecisionPad need not be running while
the server is collecting ballot input.
As people make entries you will see how far along everyone is:

A subtle point is that there are two clocks at work here, your computer’s and the server’s, which are
rarely exactly synched. Usually this can be ignored, but if they differ by much you could have one
thinking the project is closed and the other one not for a few minutes. It is also necessary
sometimes to show the UTC or Greenwich Time because that is universal, independent of which
time zone each computer’s clock is in. Otherwise times are shown as local time for your computer.
The buttons at the bottom give you control over the ballot collection:
�

Collect and Close – this stops the ballot entries, merges everyone’s inputs (finished or not)
and downloads them into your matrix and report views.

�

Peek – this downloads the latest updates to the entries to your project but lets the ballot
entry continue.

�

Abort – stops the balloting but does not collect the latest information. If you had done a
peek those entries will be kept but anything afterwards would not.

�

Close – just closes this dialog box but does not affect the server processes. You can close
DecisionPad while balloting is underway, reopening the file for a peek or ballot close.

The Collect and Close button asks for instructions and confirmations before it closes:
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You can specify a custom message of your own for people who try to access the closed ballots or
just let it say there are none. Click Close Balloting to confirm that is what you want to do:
If for some reason your internet connection fails between the time the ballots are merged for a
peek or close and when the local project copy is downloaded and updated, you can try again. For
Peek just click the button again or for Close use the Refresh button to retry the download.
Start Balloting Button:
One of the requirements checked at this point is that any evaluator or user assigned a ballot is
required to have a login name and password set in the Project, Evaluator-User menu item.
Click the Start Balloting button and tell it to Save the project (.dp4) file which brings up the launch
dialog:

The Browse Server button is used to assign or modify the server folder assignment. See the
Balloting Web Server Management topic below for how it works. You can do so at any time, or
wait until DecisionPad asks when it needs to know.
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Evaluator’s Last Time Edited controls whether this round of balloting will show when any edits were
made during the last time or show all ballots as New.
Start Balloting Time gives you the option to make them available immediately or at some future
time. Close Balloting Time can be whenever you use the Close Balloting button or at some
scheduled future time. Times are set to the nearest hour. If you specify either time you will also
have the option of what message potential balloters would see.
The Start button uploads the files, prepares the balloting server and launches you ballots. This
may take a minute or two. When launched it will switch to the Monitor Status tab.
Balloting Web Server Management:
Balloting is supported through a DecisionPad subscription folder provided as a cloud service by
Apian. A copy of your DecisionPad project file is uploaded to the server and ballot web pages are
constructed for it. The participants in the decision access those ballots from any browser and send
the weights and values you specified on the Who-What tab above. When the ballots are collected
they are merged into the project file copy on the server which is downloaded to your local
computer. Folders have names like “C001234”, the letter C followed by exactly 6 digits.
Project files with ballots and the server folders are password protected. The .dp4 project files with
passwords are encoded on the disk (take a look at the sample Tutorial-4 versus Tutorial-5 to see
the difference). Files, transactions and ballots are sent over an https SSL encrypted secure link to
the server. Every transaction message between your DecisionPad and the server is authenticated
by the folder name-password combination you provide. The Apian server computer itself has a
high level of firewall security in a controlled access facility.
One project at a time can have active ballots in one folder. If you are running two decision balloting
processes at the same time you will need two folders. A folder will come with the purchase of
DecisionPad which is valid for some period of time; you can purchase additional time or more
folders from Apian Sales at sales@apian.com or 800-237-4565, or by going online to
www.apian.com.
Folder Selection:
A folder can be assigned or reassigned either via the Browse Server button on the Start Ballots
dialog or the Message tab of the Email Invitations dialog. This brings up the selection dialog:
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The list will have just the <add server> entry for a new DecisionPad installation. As you use
folders for projects they will be added to the list. Note this is not all the folders you might have
access to, just the ones you have used from the computer you are logged into.
You may see folders with <folder expired> or other notation letting you know it is not currently
active. Contact Apian Sales at sales@apian.com or 800-237-4565 to re-activate.
If the <add folder> item is selected the Use button will be labeled Verify. Enter the folder name
and password, and click the Verify button. When a folder is assigned you will have received a
temporary password which you will be asked to replace the first time it is accessed (see Change
Password below). If access is approved the folder will be added to the list and the button label
switched back to Use.
Identify the subscription folder and click the Use button. If another project is in that folder you will
be asked to confirm it is OK to overwrite it. The project file name and if known, the administrator’s
contact information, will be shown in the warning popup.
The Edit button brings up the Change Password dialog.
Change Password:

The password is yours, please be sure to write it down. Apian staff cannot retrieve it for you
although the registered account owner can request that we reset it if lost.
The rules for the password require something non-trivial and hopefully non-obvious. It can use the
ANSI character set which includes most European accented characters. It cannot have the full
Unicode set with oriental or other extended alphabets, or the < > | characters. Blanks or
upper/lower case changes are taken literally. Examples:
Sunshine148 Yes, mixed letters and numbers
1-;-4-8Yes, mixed numbers and punctuation
Sun :) shine Yes, mixed letters and punctuation
Sun�shine
Password
>MyCat

No, uses an extended Unicode character
No, all letters and obvious
No, too short and uses >

If you ask the system to remember your password it will be kept in your computer’s Windows
registry, more convenient but possibly less secure.
Session Underway:
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Only one DecisionPad user at a time can be connected to a balloting server folder. The active
connection between one DecisionPad and one folder is called a “session”. If one person is using
the folder you try to access it the message above appears to ask what to do.
If the session time is pretty current and you know there is someone else likely to be sharing it then
say No because you do not disconnect them. You would need to wait until they are done or use
another folder.
This warning can also appear when a previous session did not get closed out properly, usually
because the DecisionPad program was not closed before turning off the computer or because the
internet connection was lost during a session. The server thinks the session still exists when it was
actually broken. Then you would answer Yes here to let it know it is safe to reconnect and start a
new session.
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Email Invitations:
DecisionPad includes a facility for inviting people to complete their ballots based on the email and
other contact information supplied in the Project, Evaluators-Users menu, and by the current state
of the balloting. Each batch of invitations is created by a 3-tab dialog box:

All of the evaluators and users are listed with an indication of their current status. You simply mark
the ones you want to send in this batch. If balloting is underway the Get Status button will let you
get the latest completion information for them, such as when you want to send reminders.
Send Emails will start the mailing process once you have the Send To and Message tabs
completed. Save Edits just saves the settings you have so far and returns to the main screen.
Edit Contact allows you to change the name, email address or phone for the highlighted user.
Changes to the contact name, email and/or phone are saved and will affect any new emails
immediately. However if there are ballots underway on the server, the names on the server ballot
copies will not be changed until new ballots are uploaded.
Mail Server:
The Mail Server button allows you to set or edit the server settings, which generally need only be
done once. You can set it whenever you like or wait until DecisionPad is ready to mail and asks for
it.
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You will need access to an SMTP (Simplified Mail Transport Protocol) server to send the mail,
often provided by Exchange Server in a Windows network environment or remotely via a web link
to your ISP. This is generally the way Outlook and other programs do their mail so the correct link
should be available from your IT department or ISP, or perhaps from the send mail configuration
dialogs of your email program.
The server can be addressed by a name like smtp.yourisp.com or by a number like 10.0.0.5. The
example above uses the Windows default server which is usually available when you are
connected to email for Outlook. Your IT department can give you the numeric host address and
optional port number. The default will work in many cases whenever your normal email is
available; it does no harm to try a Test with it.
When you click OK to set the mail server it simply saves these connection parameters for use later
when the first email is sent. OK does not do a login. You can force it to send of a short email first
with the Test button to confirm the service is actually available. It will request your email address
and send a message like "Server test using: 10.0.0.5" to you. If the SMTP server accepts this test
message to be forwarded then DecisionPad considers the test to be successful. Next check your
inbox to verify the message actually arrives.
If your SMTP server requires a login which is not automatically supplied by your computer, when
DecisionPad goes to connect for sending mail it will ask you for the authentication settings:

These server settings are saved in your Windows registry since they are most likely to depend on
what computer the project is running on rather than the particular decision project. Running
DecisionPad the first time on a different computer will require resetting the server.
Message Tab:
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The Headers section defines the common email elements: from address and subject (both
required) and an optional file attachment. The from address is usually the decision administrator or
manager. Make the subject as meaningful to your audience as possible so it does not get treated
as spam.
The Message is filled in with a typical invitation just to get you started. The items in curly brackets
like {{Ballots At}} will be filled in with this DecisionPad project’s information for each user. You can
edit them as text but it is safest to insert new ones using the Optional Variables list:

Most reflect the person receiving each email. Ballots At is the URL of the DecisionPad balloting
server for this ballot set, including the folder number. If you have not assigned a folder to this
project yet click the Browse Server button to do so. See the Balloting Web Server Management
topic on p. __ for how that works.
The Links section can insert web URLs or email addresses that will apply to all recipients:

DecisionPad 4 Reference Guide –4/6/2011 – © 2009-11 Apian Software Inc – Page 51 of 86

In the html message the Text to Show will be visible and the Web or Mail Address will be behind in
a clickable link. Link names are set once when New; they remain the same for future edits.
The web link example might be to a page of various web site design options you are deciding
between. The email link example would let participants email questions to you as the decision
administrator, flagged with a meaningful subject.
Links you define will appear in the message like “{{Link-Sample Page}}”. To edit one highlight or
put the cursor on any part of the link and click the Edit Selected button.
To Default resets the message to the default message text.
The Test Send button will send a copy of the message to you, though some variables will not be
entered:

Click Send EMails when you are ready to send the batch. This will get a confirmation dialog of the
people who should get mail:
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When you click Ok the messages will be sent and logged in here.
Note that success at this point means that the message and its addressing was accepted and sent
into the web. If the address is actually not a real mailbox or is rejected by the recipient, it will come
back to your from address as a “bounce”.
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Section 3: Definition Dialogs
Alternative Definition

When defining an alternative the Name field is the only thing that is required. The Notes field is for
optional comments on each alternative that can be displayed in various reports.
Tip: It is best if you keep the alternative name short and put descriptive details in the note.
The Alias is a way to publish anonymous reports, like showing vendors how they ranked without
revealing who their competition was. The Alias name is automatically generated with random
characters that do not match any other alternatives.
The buttons next to the name allow you to Cut, Copy and Paste in the Name field. The buttons
above the Note allow modifications of the font. Also displayed are the Cut, Copy, Paste and Paste
Unformatted buttons. The latter two give you a choice of whether to paste with formatting or
without. Generally the Unformatted one is best coming from another software product because it
gives your DecisionPad file global text style control.
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Criterion Definition

When defining a criterion the Name field and the Scale Field are required and the Note field is
optional. It is best if you keep the criterion name short and put any descriptive details in the note.
The bold, italic, etc buttons apply to the notes field not the name, and will apply to whatever Text
Style the criterion has been assigned.
Criteria require a Scale selection in order for the criteria to become active in the decision. Scales
convert the evaluation words into a score or point percentage. If you pull down the scale list you
see the built-in ones plus any you have added:

Pick a scale from the list or use the buttons above the list. There is a pencil point to add a new
scale, a pencil body to edit the selected scale, a pencil eraser to delete it or the camera to copy the
scale. You cannot delete a scale in use by other criteria but you can modify it. Remember when
you make modifications to a scale that is shared with other criteria will affect all the criteria using
that scale. The built-in comment scale cannot be edited.
Normally you would set a scale when the criterion is created but you can defer this. DecisionPad
will remind you on Ok that the scale is not set though you have the option to save it anyway.
For more on the role of scales see the Tutorial Guide and the Scale definition dialog below.
When multiple evaluators 3D is enabled there will be an option to set the criteria’s global-individual
states. For more on g-I see Project, Evaluators-Users p. 21:
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Criterion Group Definition

Groups allow you to build a hierarchy for criteria or other groups in an outline-like format. They can
be nested as deeply as you wish, in effect creating what some call an Analytic Hierarchy.
When defining a criterion group the Name field is required and the Note field is optional. It is best if
you keep the criterion name short and put any descriptive material in the note. The bold, italic, etc
buttons apply to the Note field not the Name field, and will apply to whatever Text Style the group’s
note has been assigned
When multiple evaluators 3D is enabled there will be an option to set the criteria’s global-individual
states. For more on g-I see Project, Evaluators-Users p. 21
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Evaluator Definition

When defining an evaluator the Name and Votes fields are the only ones required. Votes define
how influential each evaluator is in the summary, and start out as 1. Integer values starting at 1
are expected, although 0 is allowed. The Notes field is for optional comments on each alternative
that can be displayed in various reports.
Tip: It is best if you keep the alternative name short and put descriptive details in the note.
The Alias is a way to publish anonymous reports, like showing vendors how they ranked without
revealing who their competition was. The Alias name is automatically generated with random
characters that do not match any other alternatives.
The buttons next to the name allow you to Cut, Copy and Paste in the Name field. The buttons
above the Note allow modifications of the font. Also displayed are the Cut, Copy, Paste and Paste
Unformatted buttons. The latter two give you a choice of whether to paste with formatting or
without. Generally the Unformatted one is best coming from another software product because it
gives your DecisionPad file global text style control.
Evaluators can also be defined together through the Projects->Evaluators-Users menu item, which
is used initially to add the evaluator dimension to the DecisionPad matrix. See p. ___ for this
option.

DecisionPad 4 Reference Guide –4/6/2011 – © 2009-11 Apian Software Inc – Page 57 of 86

View Properties Definition
This is a multiple-tab dialog with many similarities between the matrix and report views, though
some tabs or controls will come and go depending on the view.

Labels:
The first tab covers the labeling of the view with optional title, a paragraph of explanation and
footer. These will show in any printout, but will only show for reports on the editing screens. The
buttons for text styles are pencil point adds, pencil body edits and camera copies.

Layout:
The layout tab places the logo, if desired, selects the text style to use for the body and some
settings that will vary depending on the view type.
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Matrix Layout:
Here the matrix type allows selecting Show Impacts to mark the cells most affecting the
decision, either as arrows showing the largest impacts:

Or as spark bars showing all of them:

The impacts are computed by looking at the scored-weighted effect of each value cell on
the ranking as a difference from the average of the criterion row. The impact bar graphs
show the effect for better or worse such as:
moderate positive impact
��no impact
large negative impact
The arrows flag the biggest effects based on the standard deviation of the impact
distribution when there are more than about 10 cells and when the distribution has about
1/3 or less of the cells that are significantly different. Impacts are computed within each
evaluator or the summary, reflecting the strengths and weaknesses as seen by that
evaluator.
See the Tutorial Guide regarding Sensitivity Analysis for more on how to interpret impacts.
Show Sparks enables a small bar graph of the score for each cell instead of its value.

Show Group Scores lets you make the computed score for each group visible. Default is
off.
Report Layout:
For any of the reports you can choose which notes to show:

Scores:
For the Scores report you can also select whether to show them as Bars or as Scatterplots:

The bars show the values for each criterion and alternative as the values convert to scores
and then for the total scores:
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By showing the ranges that result from uncertainty you can see when an alternative has
come to dominate regardless of the question marks. Here Fred’ Iron Works overlaps
Gate’s by Sally. Until some of the unknown criteria are resolved you do not know which is
best. See the Tutorial Guide for examples of score range interpretation.
The scatterplot option can be a good way to quickly show the strengths and weaknesses of
the options on pairings of criteria:

Unknowns cause the markers to plot outside the score range square. If both criteria are
unknown the markers plot off the upper right corner. If one is unknown it will plot at the
other criterion’s value just outside it’s known axis.
When 3D is enabled you have the option to compare pairs of evaluators for total scores
and/or selected criteria. This is helpful in finding the best compromise solution – it will be
the alternative then is generally up and to the right for all evaluators even though it may not
be the absolute best for any of them.
Weight Sensitivity:

The default is to track the top 3 alternatives in the weight change tables but you can select
other numbers. The graph of how much each criterion uses of the score range can be
shown or hidden.
The “spark” for ranking shifts plots at the current weight and (1) every high-low word weight
possibility, or (2) every 12.5% from 0 to 100% or (3) 0 to 3 times (3x) for numeric and point
weights. These are changes to one criterion at a time; the rest of the relative importance
relationships are maintained. If the rest of the relationships change then so will the
sensitivity to any one criterion, thus it is just one way to assess which weights really matter.
Individual Alternatives:
The Individual Alternatives report shows the results on a page or two for each alternative,
which might be used to discuss the evaluation with each vendor or employee. It is
controlled by:
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Alternatives/Musts/Weights:
For control of alternatives in the report or matrix go to the Alternatives/Musts/Weights tab. This tab
give you control over how the alternatives appear in the report or printed matrix, how they are
sorted and numbered.

The alternatives tab will often contain controls for weights and/or must haves.
The Sort Rules are listed in the upper-left corner, including Sort by Criteria which uses the scored
values of that criterion as the sort basis. The sort rules are also controllable from the right-click
popup menu inside the Matrix.
The Show area controls how labeling is done, such as with numbers or labels.
The Selection areas have a list of the items which the Matrix or Report can present. In general
there will be a list of the possibilities. Any with a filled-in green marker are going to be shown;
those without a marking square will be hidden. The buttons on the right let you either show or hide
everything, or selectively change the item selected.
Note that the selection list works like an “opt-out”. In other words when you add a new alternative
it will be shown in all existing views unless you explicitly say otherwise.
Criteria/Scores/Ranks:
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The Critera/Scores/Ranks tab gives you control over which items appear in the report or printed
matrix, how they are sorted and numbered. The criteria tab will often include the score and/or rank
items.
The Sort Rules in the upper-left are self-explanatory.
The Show area controls how labeling is done, such as with numbers or not. Without criterion
groups your numbering choice is Yes or No. With criterion groups you can chose to show the Full
outline-number like 1.2.3 or just the criterion’s Own number within its group like (3).
The Selection areas have a list of the items which the Matrix or Report can present. Any with a
filled-in green marker are going to be shown; those without a marking square will be hidden. The
buttons on the right let you either show or hide everything, or selectively change the item selected.
The selection list works like an “opt-out”. In other words when you add a new criterion it will be
shown in all existing views unless you explicitly say otherwise.
The Scores Report, non-scatterplot, is a special case in that it has a Show Total Scores Only
option. This overrides the selection and the opt-out nature of new items. Combined with sort
alternatives by ranking, this makes a nice summary of the decision conclusions.
If you bring up the View Properties for the default Matrix, view number 1, you will see that the
selection options are not available. This base matrix is the primary way of interacting with the
decision structure which becomes confusing if things are hidden; it always shows all the rows and
columns. To show subsets make a new matrix view and use the selection tools for it.
The Tutorial Guide has examples of using these controls.
Evaluators/Summary:
For control of evaluators in the report or matrix go to the Evaluators/Summary tab. This tab give
you control over how the evaluators s appear in the report or printed matrix, how they are sorted
and numbered.
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The Sort Rules are listed in the upper-left corner. The sort rules are also controllable from the
right-click popup menu inside the Matrix view.
The Show area controls how labeling is done, such as with numbers or labels, plus whether the
Votes are displayed.
The Selection areas have a list of the items which the Matrix or Report can present. In general
there will be a list of the possibilities. Any with a filled-in green marker are going to be shown;
those without a marking square will be hidden. The buttons on the right let you either show or hide
everything, or selectively change the item selected.
Note that the selection list works like an “opt-out”. In other words when you add a new evaluator it
will be shown in all existing views unless you explicitly say otherwise.
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Scale Definition
Scale definitions use a two-tab dialog. The first tab General applies to any scale:

The General tab has fields for a required unique Name and an optional Note. It is best if you keep
the scale name fairly short and put any descriptive details in the note. The bold, italic, etc buttons
apply to the notes not the name, and will apply to whatever Text Style the scale’s note has been
assigned.
The General tab also allows you to define the Scale Data Type. There are 5 basic types of active
scales Keywords, Numbers, Dates-Times, Rating and Forced Rank (the Comment scale is built-in,
un-scored and not editable). Each of these has its own tab which will appear when you chose that
Scale Data Type radio button when in the General tab.
The screens for each Scale Data Type shown below utilize the default 0-to-10 scoring range. If
you want to change the default score range go to Project > Scoring. If you decide to use points
instead of number or word weights then the dialogs below would show the percentage of the
criterion’s possible points to be given each value.
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Keyword Scales:

Keywords are like the Excellence scale shown here. On the right side you have the Keyword List
in the order they will appear in matrix pulldown lists. Above the keyword list you have Add, Insert,
Delete, buttons that allow you to add new words to the end, insert in the middle or delete them.
You can also move the words up or down in the ordering with the Up and Down buttons. Edit the
labels by typing directly into the label column.
On the left you chose the Scoring Rule for this scale. Here the First Word Highest Score is
selected and the score range is automatically spread across the other boxes with the first word in
your list being the highest score. As you edit the Keyword List the scores will remain with the first
word in the list being the highest score. The same idea applies to the First Word Lowest Score
option.
The third choice, Set Score for each Keyword, let’s you set scores individually by typing values into
the Score column of the list. The values must be within the overall range but otherwise can be
whatever you wish. For example, the built-in Yes/No scales do not use the whole score range:

Typically when people set up subjective scales they do not use the full range in practice – we
generally avoid saying “unacceptable” -- hence the 2 and 8 for the Yes-No built-in scale above.
There are also times when you do not want equal steps, a “non-linear” utility curve, so you need to
set the steps directly. The last use is where the middle is better or worse than the ends, what
might be termed a “Goldilocks” scale.

DecisionPad 4 Reference Guide –4/6/2011 – © 2009-11 Apian Software Inc – Page 65 of 86

The Graph button provides a quick check on the scale settings. Here are some samples of what
will pop up for Excellence 5 levels, Disagree 5 levels and a ‘Goldilocks’ scale:

Number Scales:

With Number scales the Set Scores choices determine the scoring. How this looks depends on the
setting in the Scoring Rule.
Set Two End Points says what number gets the highest score and which the lowest. The numbers
can be fixed, like the 0 above, or floating with Max or Min.
Selecting the End and Ratio rule gives this structure:

This scale might say something like “the fastest number is best, whatever it turns out to be, and
half of that gets the lowest score”. Remember that importance of a criteria in the decision is
another matter, expressed by the weights in your decision matrix.
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The third Scoring Rule lets you set breakpoints for a shaped relationship.

This draws a rough curve of score or utility versus number. For numbers between -15 and 3 the
score would be a declining straight-line between 8 and 5, and so forth.
For any scoring rule, when a number is above or below the ends, then it gets the end’s score.
Thus if 1200 was assigned the highest score of 10 then anything above 1200 would also be scored
10.
You should set-up number scales carefully to properly represent the utility of various numbers, with
special caution using Min and Max.
The Format section controls how the numbers will be shown, such as $1,234.56 set above, or 23%
or (432) €. The Symbol/Units entry can be with or without one space. You can either type number
values into the matrix as a plain number or with the formatting; other combinations will be rejected.
Remember that Windows has a utility called Character Map that will help you find special
characters not on your keyboard.
The Graph Button shows the scoring; here are some examples:

When the scoring ends on a particular value then the graph reminds you that values above or
below that value will be assigned the ending score. Thus an 11 gets a score of 0 and a -6 gets a
score of 10 in the middle 9 to -5 example. The last example is for the non-linear scale.
Minimum and Maximum are very handy but should be used with care as they can understate or
overstate the utility differences between alternatives. This is particularly true when there are
unknown values that you may want to leave in if the decision otherwise seems settled. These
issues are covered in the Tutorial Guide with examples.
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Date-Time Scales:
Date-Time scales follow the same idea as the Number scales above.

These are straightforward, basically taking the time differences in seconds. When the dates are
listed as month and year, the 1st of the month is automatically used for the computations.
Rating Scales:
A Rating scale has fixed end points like the -3 and +3 here. It is very similar to the Keyword scale
and has the same approach to Scoring Rules.
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Forced Rank Scales:
The Forced Rank scale sets the Number of Rank Levels and some optional Ranking Rules.

DecisionPad will apply the rules in several ways:
�

If the rank values for a criterion do not follow the rules then all the alternatives will be
scored as if they were unknown.

�

In the Matrix view a criterion with rule violations will have a colored row label. Hovering
over that criterion will popup a note of which rule(s) are not met.

�

The Value Button Set screen will show whether the values are in compliance, which makes
this screen the most convenient way to set rankings for a lot of alternatives (for more
information on Value Button Set see p. 32).

Otherwise ranking is very similar to the Keyword scale with the same approach to Scoring Rules
and similar caveats about setting appropriate scores. With forced ranks, give some thought to
whether alternatives that are not in the top rankings deserve a 0 score, the 4+ case above.
Perhaps the scoring should be set for a narrower range instead of using the automatic
assignments..
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Text Style Definition
Text Styles are reusable descriptions of fonts to be applied in the various views. If you edit a Text
Style, all the places that use that Text Style will change appearance. 4 styles are built-in: Matrix
Style, Report Style,Title Style, Footer Style. These styles can be edited but not removed.
Here is the default setup for the footers, a 9-point italic Arial font.
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Section 4: JumpStart
Welcome

JumpStart is a wizard to step you through the development of a decision matrix. It is intended to
provide a first draft to be editing using the full DecisionPad program capabilities. The wizard has
explanation and ideas for each step to help you develop the criteria and alternatives for the project.
These welcome screens are an introduction to the process.
You navigate with the buttons on the bottom:
Cancel ends the JumpStart session, with an option to save to partial results
Back and Next buttons are the usual wizard steppers
Finish is activated when you get to the end. Finish converts the JumpStart information into
a DecisionPad Matrix and sends you to the main screen for further work.
Help brings up these explanations of how the screen controls work
File Save saves your work to a local disk file. It will be enabled once there is something to
save.
The next screen describes what criteria are:
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Next the setup process begins with picking a decision type.
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Select a Decision Type

JumpStart recognizes common categories of decision so it can provide meaningful options for
criteria. At this stage pick the closest type to what you are doing and click Next.
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Set Criteria

The criteria suggestions for each decision type are gathered into 4 or 5 groups which are
presented one at a time in screens like this. Since it is a wizard you can step ahead to see them
all before you start to enter any, and then go Back to start filling them in.
You can skip a group if it is not useful. You will have the opportunity to add more groups later if
you like. The group labels can be kept in the final matrix or dropped at your choice later in the
wizard.
The suggested group name is shown, but you can override it.
The criteria in the group for your decision are listed in the center panel where it says Criteria
Labels. You can add labels by either
�

Typing the label, ending with the Enter key to insert it, OR

�

Select from the idea list at the left with a double-click or the Use button.

Once a label is in the list you can edit it directly, whether or not it came from the idea list originally.
Criteria are one line labels and should be kept short. Put any descriptive detail in the note area at
the right which will be attached to the criteria.
Criteria can be deleted or moved with the buttons under the list.
Each time you click Next it will present another of the group ideas. For example the Buy, Lease or
Bid decision category has ideas for Specifications, Costs and Logistics, Quality Factors and
Vendor Support. After these it will let you add a group of your own if you wish.
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Adding a Group

If you do not want to add a group just click Next.
Otherwise type in a group name and the criteria list will appear. You can add labels by typing the
label, ending with the Enter key to insert it. Once a label is in the list you can edit it directly. The
can be deleted or moved with the buttons under the list or notes added.
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Review Criteria List

Here you can work on the criteria list in an outline format. Once a group or criterion is selected you
can:
Edit name by typing in the edit box below the outline list
Optional note adds a description of the criterion. It is best if the label is kept short and
details covered in the note.
Move Up or Move Down let you adjust the criteria order, not only within a group but into the
adjacent one.
New Group and New Criterion insert blank ones in the outline
Delete removes the highlighted item. You will have the option to Undo Delete immediately
after the deletion in case it was an accident. This is not a general purpose undo however.

DecisionPad 4 Reference Guide –4/6/2011 – © 2009-11 Apian Software Inc – Page 76 of 86

Role of Scales

In order to handle the apples-and-oranges nature of criteria in real decisions, DecisionPad needs
to convert the values into a common measure of usefulness or utility. It uses scales to do so as
this screen explains.
The default is a score range of 0 to 10, but you can override this now or later in the full
DecisionPad. If the people involved in this decision are used to something else like -3 to +3 or
using a point allocation system you can select it here.
For more on scoring and scales see the Tutorial Guide.
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Set Scales

Normally you would assign scales to the criteria here, but you can defer that for some or all of the
criteria until later in the main DecisionPad matrix screen. Any assignments made here can be
changed later – JumpStart is a rough draft.
To set a scale, select the criterion and then select an existing scale or create a new custom one.
For more on the general issues around setting up scales see the Tutorial Guide or the scale
definition screens section of this Guide starting on p. 64. The tutorials are particularly useful for
scaling numbers like specs or costs.
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Weights for Criterion Importance

At this point the criteria are presumably defined, at least for a first draft. They can be changed later
of course. You have two sets of choices to move forward:
Weights as sets your weighting method which defaults to percentages. You can also have
Words for weights which some people prefer. See the Tutorial Guide for more on weights.
Group handling determines whether the criteria groups you have been using up to now will
appear in the final matrix. You can show all or none of them, or let JumpStart just keep the
ones with more than one criterion.
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Sliders to Set Weights

The weights are always relative, hence the sliders instead of a list of numbers. With these
percentage weights DecisionPad will take care of the math for you: move of weight up and the
others will drop while maintaining their relative importance. You can elect to leave them all equal
for your draft or take a preliminary cut at their relative importance now.
Weights are set for the group level first if groups were kept and then for the criteria within each
group
When you finish the JumpStart draft you would have the option of two other weighting methods:
subtotaled numbers or points. Any relationships you set here will be retained if you switch.
Sort Hi->Lo, Sort Lo->Hi and Unsort buttons give you control over how the order of groups or
criteria shown in this screen. It does not affect their order in the outline you established earlier.
When there are a lot of items people will typically take a cut with the sliders, click one of the sort
buttons, look at the importance order and profile, and make adjustments until it reflects their
decision input.
By Pairs lets you set relative weights for criteria two at a time.
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As soon as you set at least one comparison for each criterion the Finished button becomes
enabled. You can then do as many more as you wish; more will refine the relationships all the way
up to the maximum which compares every criterion against every other.
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Alternatives

This is an introductory screen; when you click Next it goes to:

Alternatives can be entered by typing them into the Alternative Labels list. Once a label is in it can
be reordered or deleted with the buttons below it. You can also add detailed descriptive notes in
the right panel.
You can defer adding alternatives until after the draft is converted to the main matrix screen.
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Overall Notes

This series of screens define optional overall notes to help document the decision. They can be
added or edited in the main Matrix screen later too.

Completed JumpStart Wizard

This is the last screen of the wizard sequence. You can back up to make changes and additions to
your draft structure, or click Finish to convert it to a DecisionPad matrix for further work.
File Save here will be in the wizard format so you can revisit the wizard later. Once you click Finish
it will be converted to the matrix format and cannot be viewed in JumpStart anymore. For the
example screens above the martix came out like this, ready to enter the product ratings:
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Balloting. See Balloting
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Start, 44–45

Login Setup, 24
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Self-registration, 27
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File Menu, 14–18
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JumpStart, 73, 75
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JumpStart, 74

Import, 15–16
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Cut or Copy, 32
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Delete, 32

Add Criterion Group, 74

Edit, 31

Alternatives, 81
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Paste, 32
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Prune Alternatives, 34–35
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Overall Notes, 82
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Notes, 8, 20–21, 31, 53, 54, 56, 58, 63

Criteria/Scores/Ranks, 60–61

NR (Not Ranked), 20, 35

Evaluators/Summary, 61–62

Outline view. See Tree

Experiments, 34, 36–37

Overall Notes, 20–21

Individual Alternatives Report, 59–60

JumpStart, 82
Project Menu

Labels, 57
Layout, 57–60

Logo, 30

Matrix, 7–8, 9, 58

Overall Notes, 20–21

Scatterplot, 59

Scoring, 19–20

Scores Report, 58–59

Text Styles, 22–30

Sorting, 60–61

Prune Alternatives. See Edit Menu
Right-click Menu, 8, 10
Scales, 63–68

Weight Sensitivity Report, 59
Views Menu
New Experiment, 36

Dates or Times, 67

New Matrix, 36

Forced Rank, 68

New Report, 36

Graph Scoring, 65, 66

Open Window, 37

JumpStart, 77

View Properties. See Views

Keywords, 64

Weights, 19–20, 33–34

Name and Notes, 63

JumpStart, 78–80

Numbers, 65–66

Numeric, 19

Ratings, 67

Points, 19

Scoring and Ranking, 19–20, 58, 63–68
SMTP. See EMail Invitations

Words, 19
Welcome, 5

Sparks, 58
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